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Cam Designer Basic
About this Manual
Conventions used

This Manual contains information about Lenze Cam Designer Basic.

The »Cam Designer Basic« is a software which is used to transfer recipes consisting of mo-
tion profiles, cam tracks and position markers from a PC to Lenze target systems.

Special features of the »Cam Designer Basic« are:

» Import of CAD data via standardised interfaces (VDI 2143).

» Program operation via an easy-to-use PC user interface for the first commissioning and
the preparation of additional functions to be provided to the final user by the mechan-

ical engineer.

» Smoothing of imported CAD data (motion profiles) for a smoother running of the

drives.

Conventions used

This Manual uses the following conventions to distinguish between different types of in-

formation:

Type of information
Variable identifier
Window

Control element
Sequence of menu

commands

Keyboard command

Program listings

Keyword
Link
Safety information

Step-by-step instruc-
tions

Tip

Marking

italic

bold

<bold>

Courier

Courier
bold

underlined

Examples/notes
Set bEnable to TRUE to...
The message window... / The Options dialog box...

The OK button... / The Copy command... / The Properties tab... / The
Name input field...

If the execution of a function requires several commands, the individual
commands are separated by an arrow: Select File=*Open to...

Use <F1> to call the Online Help.

If a command requires a combination of keys, a "+" is placed between
the key symbols:
Use <Shift>+<ESC> to...

IF varl < var2 THEN
a=a+1
END IF

Links are highlighted references which are activated by means of a
mouse click.

|» Layout of the safety information |(L1 6]

Like safety information, step-by-step instructions and tips can be recog-
nised by an icon.

2.1EN-09/2005 5
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Layout of the safety information

1.2 Layout of the safety information

All safety information have a uniform structure:
» The icon characterises the type of danger.
» The signal word characterises the severity of danger.

» The note describes the danger and suggests how to avoid the danger.

A Signal word

Note

Icon Signalword  Meaning Consequences if disregarded

e Danger! Impending danger to persons  Death or severe injuries

hazardous
electrical
voltage

A

general dan-
ger
Stop! Potential damage to material Damage to the controller or its environment

® Note! Note

1

6 2.1 EN - 09/2005 l-enze
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Connection with the target system

System requirements

The following minimum requirements on hardware and software must be met to use the
»Cam Designer Basic«.

» Microsoft® Windows® 98, Windows NT® 4.0 (as of Service Pack 5),
Windows® 2000 (as of Service Pack 2) or Windows® XP.

> 64 MByte RAM
128 MByte RAM (Windows® XP/2000)

IBM compatible PC (CPU: Pentium 90 MHz processor or faster)
Super VGA screen

Hard disk with at least 120 MB of free disk space

CD-ROM drive

vV vvyyvVwvyy

Mouse (Microsoft-compatible)

Connection with the target system

The communication with the target system (controller, Servo PLC or 9300EK servo cam) re-
quires a fieldbus-specific interface module for the PC and the corresponding fieldbus mod-
ules for the target systems to be connected.

For system bus (CAN) communication, Lenze offers the following components as interface
module for the PC:

Bus system Max. number of target systems
PC port Required hardware components
System bus (CANopen) 63
Parallel PC system bus adapter 2173
port incl. connection cable and voltage-supply adapter
(LPT port) « for DIN keyboard connection

(EMF2173IB)

- for PS/2 keyboard connection
(EMF2173IBV002)

« for PS/2 keyboard connection with electrical isolation
(EMF21731BV003)

UsB PC system bus adapter 2177
(Universal Serial Bus) incl. connection cable
(EMF2177IB)

2.1EN - 09/2005 7
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Software installation

3 Software installation

How to install the »Cam Designer Basic«:
1. Start Windows.

2. Insert the CD-ROM »Cam Designer Basic« into the CD-ROM drive.

« Iftheauto-start function of the CD-ROM drive is active, the installation program
is started automatically and you can proceed with step 5.

Select Run ... from the start menu.

4. Enter the letter for your CD-ROM drive followed by ":\setup.exe" (e.g. "e:\set-
up.exe") in the command line and confirm with OK.

5. Follow the instructions of the installation program.

Note!

o

Installation under Windows NT/2000/XP requires administrator rights!

8 2.1 EN - 09/2005 l-enze



efesotomasyon.com - Lenze

Cam Designer Basic
Introduction

4 Introduction

»Cam Designer Basic« is a graphic tool for the easy creation of electronic cams.

»Cam Designer Basic« provides the features of the »Cam Designer Professional« in reduced
form.

Main features of the »Cam Designer Basic«
» Easy creation of cams by means of graphic objects (e.g. lines, polynomials).
» Data is directly input using the physical unit.
» Display of speed, acceleration torque and jerk.

» Printing of the cam graphics with project information and date.

Main features of the Software Package - Cam

» 48 profiles can be stored in the PLC

» 289 base points per profile in the relative data model
P 116 base points per profile the absolute data model

» Increased number of the available base points with reduced number of profiles re-
served

» 48 cam groups can be stored
» Three tracks per cam group

» Four cams per tracks

Main features of the 9300EK servo cam
» 8 profiles can be stored in the PLC
P 256 base points per profile in the relative data model

» 64 base points per profile the absolute data model

i Note!

No names are used for profiles and projects in the documentation. The examples
use the names assigned by the system. You can assign names on your own in
your system.

The »Cam Designer Basic« is a product of the Software Package - Cam. It manages the rel-
evant data of the machine and also creates projects. However, it lacks the »Cam Manager«
and hence the ability of managing several products at the same time.

wnze 2.1EN-09/2005 9
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Entries via the »Cam Designer Basic«
» The project
Only one product at a time is available, i.e. only one product at a time can be processed.
— Machine structure
— Names of the axes

» The feed constant and gearbox factor of each axis
» Scaling of the axes for profile creation

» The master axis
— Number of cycles of the machine
The value is a rated value and can maximally amount to 199% during operation.
» The slave axes
— Number of profiles to be stored
— Number of base points to be assigned
— Selection of the data model

» The product (profiles)
— Product name
— Product number

i Note!

No names are used for projects and products. The names given by the »Cam De-
signer Basic« are continued to be used. You are able to select the names on your
own in your project.

10 2.1EN-09/2005 mnze
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Advantages of »Cam Manager«
the »Cam Manager« is not included in the »Cam Designer Basic«.

The management of projects with several products and the corresponding axes using the
»Cam Designer Basic« is only possible with a directory structure.

The »Cam Designer Professional« manages the projects using the integrated »Cam Man-
ager«.

The assignment between products and axes is displayed in the »Cam Manager«.

| ') CamManager - [Project_1.cmm]

I File Edit Wiew Window ? -|F %
LeHE & %
| Product 1 Product 2 Product 3 Product 4
M aster 1] 1 2 &
Slavel Ok LC Mo Curve Ok Interpolation diff.
Slaved Mo Interpolation Mo Interpolation Mo Interpolation Ok
Slavel Mo Interpolation Mo Interpolation Ok Mo Interpolation

Ok

EBereit I

» The products and axes are stored and managed automatically in the »Cam Designer
Professional«.

» The storage and management of the products and axes in the »Cam Designer Basic«
are provided by means of the *.LCx-files and *.cam-files
— LC9 for Servo PLC and ECS EA
— LC7 for 9300 EK servo cam

Mame Size | Attributes | Type Date Maodified
E" Noname2, cam GKE A CamDesign Document 23.05,2005 14:32
Eproduct: 1.cam GKE A CamDesign Document 16.05.2005 15:39
E product 2,cam GKE A CamDesign Document 16.05.2005 14:54
Slavel.lc? 4kKB A LC7 File 10.08.2005 11:31
Slavel.lc9 64 kKE A LC9 File 16.08.2005 12:25

2.1 EN - 09/2005 11
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Motion tasks

4.1

12

Motion tasks

According to the VDI 2143 with the title "Motion rules for cam mechanisms" the motion
tasks can be classified as follows:

Motion task Abbreviation Speed in the Acceleration in the Graphical
boundary point boundary point representation
Break R v=0 a=0 Line
Constant speed G v#0 a=0 Line
Reversal u v=0 az0 Point
Motion B v#0 a0 Point

These four motion tasks serve to formulate the technological specifications for all prob-
lems relevant to practice.

For calculating the profile segments between the defined sections, the boundary values of
the specifications are required.

100

g0+

100

e e
o a0 1o0o° 15807 200° 2807 300° 3507

P Since the acceleration for R and G is = 0, these two motion tasks can be described line-
arly. The boundary values on the left and right connection are identical in this case.

» The acceleration for U and Bis = 0. These elements can be represented as a point on the
worksheet.

After entering these basic elements for the motion tasks and determining the required
boundary values, the connections can be entered according to the motion rules. Depending
on the connection type used, a jerk-free motion can be achieved.

216N -09/2005 Lenze
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Scaled motion rules

4.2 Scaled motion rules

Each segment i of the whole cam describes a part which is defined by the value range si0 =
f(jio) and si1 = f(ji1).

» The corresponding functions are imaged internally to the scaled value range of 0...1.

» The coefficients of the profiles, included in the property pages, also refer to this scaled
value range.

» The speeds and accelerations in the property page represent the real boundary value
with regard to the geometrical dimensions. Thus, the calculation is based on the rule
v=ds /djand a=d2s/dj2.

These geometrical values for speed and and acceleration are also used in the graphical
representation.

Sit o Segment i

Sin1-—""Fn 1

Pin Pit

l-enze 2.1 EN - 09/2005 13
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User interface
Using the direct help

5 User interface

Go to the Start menu and select
Programs—Lenze—Global Drive Cam Designer Basic to start the
»Cam Designer Basic« with user interface.

The user interface contains the following control and function elements:

20 File Edit View Oraw Window ? - 8 x
Dﬁﬂé 8 S Ll N ENZ|E|]|lm @
| Pasition [mm] Slavel
oo
g— Masker
Q Slavel
G
@ . Q) Slavez
Q) Slaved
E O TE R T e e  w R e R R
H
TR e e e A e
m__—-Project Ready M
@l [E Bcreen divide|] @ Workspacd
[ Project structurd  [FIFtatus baf ]
5.1 Using the direct help

The »Cam Designer Basic« has a direct help which can be used to display information about
specific areas of the user interface.

Select the command Help—Direct help and click the area about which you want to
obtain more detailed information.

If you have opened e.g. the dialog box Project settings and click the input field Rated quan-
tity cycle/min, information about this dialog object is displayed when pressing <F1>.

14 2.1EN-09/2005 mnze
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5.2 Language selection
You can always select another language for the menu, dialog and help texts of the »Cam
Designer Basic«.

» The available languages depend on the language files that have been installed togeth-
er with the »Cam Designer Basic«.

How to select another language...
1. Select command View—Set language.
2. Gotothe Language configuration dialog box and select the desired language.

3. Click OK to confirm your selection and close the dialog box.

5.3 Title bar

The title bar at the top of the application window shows the program icon and the program
name on the left and the window icons on the right.

» With a click on the Window icons _ [ & you can change the representation of the
application window as follows:
— lcon in the task bar ()
— Full screen ()
— Window size (&)

» Aclick onthe programicon opens the system menu which also includes commands for
positioning and changing the size of the application window.

» Aclick on the window icon X or a double-click on the program icon exits the »Cam De-
signer Basic«

5.4 Menu bar

Via this menu bar you have access to all menu commands of the »Cam Designer Basic«. In
contrast to the »Cam Designer Professional« the profile functions are reduced.

» Aclickon anitem of the main menu opens the corresponding menu and lists the menu
items contained in it.
» Click a menu item to execute the corresponding function.

— Menu items which are displayed in light grey are currently deactivated because the
execution of the corresponding function would not make any sense in the current
program state.

- Tip!
Many frequently used functions can be executed faster by means of the
icons.[( 16]

wnze 2.1EN-09/2005 15
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Toolbar

5.5 Toolbar

The display is optional.

Via the icons of the toolbar you can easily execute some of the most frequently used menu
commands without making a detour via the Menu bal. The selection of the available func-
tions depends on the active mode/window.

» Simply click an icon to activate the corresponding command.

Icon Menu command Function
M File-New Creates a new Cam Designer Basic project.
= File=Open Opens a Cam Designer Basic project.
E File»Save Saves the project under the current name.
% File=Print Prints the project.
.:Iu’lo Edit—Cut Deletes a selected object and moves it to the clipboard.
Edit->Copy Copies a selected object and moves it to the clipboard.
Edit—Paste Pastes a copied or cut object into the current position.
- Edit-+Undo Undoes the last action.
= Edit-Redo Redoes the last undone action.
{:—i View=Zoom In Enlarges the worksheet view.
{i View—Complete View Resets the worksheet view to standard size.
Edit—> Opens the acceleration dimensioning dialog.
@ Acceleration Dimensioning
File— Establishes a connection to the OPC server.
%’ Connect to OPC Server
Lex File— ] Opens a dialog for selecting a drive.
- Create LCx-file and Download
Ak Draw—Select Selects the drawing objects.
Draw-sLine Draws a line.
.
~5 Draw—>Polynomial (5.) Draws a 5th grade polynomial.
ﬁ-.f Draw-»Sloped Sine Draws a sloped sine function (Bestehorn).
£ Draw-Table Draws a table.
am View=Object Input Mode Input of motion objects.

16 2.1EN-09/2005 mnze
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Project structure

Icon Menu command Function
_"'-.f' View=Interpolation mode Changes to the interpolation mode.
Go Edit—> Connects the profile segments.

Start Calculation

G- Tipt

If you move the mouse pointer over an icon, a tool tip pops up providing a short in-
formation on the corresponding function. Moreover, an additional information is

displayed in the Ftatus bal.

5.6 Project structure

The display is optional.
The project structure consists of the tabs Project and Object.

Project
In this tab the master axis and the created slave axes are displayed.

» A double-click on the icon activates the corresponding slave axis. The associated pro-
files are displayed accordingly.

» A mouse-click highlights the name of the master or slave axis in blue. When clicking the
blue field, the name can be changed.

g— Master
Q) Slave 1
Q) Slavez

l-enze 2.1 EN - 09/2005 17
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Screen divider

Object

This tab shows the list of all objects in the active mode. Optionally, the objects of the lower
levels, highlighted in grey, can also be shown.

ToolWindow
e | xo] v [ v
Poly2 00 400 750 500
Polya 750 500 1400 150
Poit 1150 650

PolyS 1400 150 2050 550
Line 2050 550 2950 550
Trapez 2950 550 3600 500

' Project | Obiect |

» Eachlineinthe list contains the object type and coordinates of the object. The lines are
sorted according to the X values (master) as standard. A different sort sequence can be
achieved by a mouse-click on the fields in the headline.

P Itis possible to select one or several objects in the list by means of the mouse. The se-
lection is also transferred to the graph of the worksheet.

» A click with the right mouse button on the corresponding object opens a submenu
which contains various functions. The property dialogs of the objects can be opened,
the object can be copied or deleted.

In the Objects tab, the lines, profiles etc. can be edited.

5.7 Screen divider

The screen divider is the border between two non-overlapping windows. In the »Cam De-
signer Basic« there is a screen divider between the worksheet, time derivations and the ob-
ject list.

5.8 Workspace

The document windows (worksheets) are displayed in the workspace.

» When the»Cam Designer Basic« is started, the workspace is blank because there are no
open projects.

» The worksheet is the area for entering and editing graphic objects.

5.9 Output area

The display is optional.
» This diagram displays the time derivations of the objects from the worksheet.

» In this diagram, the cams of the individual tracks for the target systems Servo PLC and
ECS EA can be created and edited.

18 2.1EN-09/2005 mnze
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User interface
Status bar

Status bar

The display is optional.
The program status is indicated in the status bar.

The status bar describes the action which is executed by the menu item selected or a
pressed button of the toolbar and displays the coordinates of the mouse pointer.

@ Tip!

If you position the mouse pointer over an icon in the [Toolba or a menu command,
more information about the corresponding function will be indicated in the status
bar.

2.1 EN - 09/2005 19
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Document window (worksheet)

5.11 Document window (worksheet)

If you open a project, the corresponding worksheet will be indicated in a document window

in the of the Cam Designer Basic.

By default, the document window is displayed on a full screen, i.e. the document window
fills the whole workspace of the»Cam Designer Basic«.

» With a click on the windowicons _ O & atthe top right of the document window
you can change the representation of the document window as follows:

— Icon within the workspace ( )
— Full screen (O)
— Window size (&)

» Aclick on the programicon opens the system menu which also includes commands for
the positioning and size of the document window.

» A click on the window icon X or a double-click on the program icon closes the docu-
ment window.

» Use the key combination <Ctrl>+<F6> to jump from one document window to the next
document window.

"Window" menu

The Window menu contains the following commands for the arrangement of the docu-
ment window:

Command Function

New window Opens a new window with the same contents as the active window.
In this way, it is possible to display different parts or views of a worksheet simultaneously.
« The new window will be automatically the active window and will be indicated above all
other open windows.
« Ifthe contents of an open window is changed the contents of all other open windows of
the project change as well.

Cascade Cascades all windows in the workspace.
Horizontal Arranges all windows in the workspace horizontally.
Arrange icons Arranges all windows reduced to an icon at the bottom of the workspace.

« Ifawindow opens in this section, it may happen that one or all icons are hidden because
they are under the window.

1,2,3.. All open windows are listed at the end of the Window menu.
A click on an entry activates the corresponding window (and places it on top of the desktop).
+ The active window is indicated by a hook in front of the entry.

20 2.1EN-09/2005 mnze
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Operation

After the first start of »Cam Designer Basic« the user interface is displayed with an empty
workspace.

» Now you can create a new project (worksheet) or open an existing project.

- Tip!
In the installation directory of the »Cam Designer Basic« you can find example

projects which can be used to make yourself familiar with the operation of the
»Cam Designer Basic«.

What do you want to do?

[» Create a new project]( 22)

[» Open an existing project |1 34)

2.1EN-09/2005 21
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Create a new project

6.1 Create a new project

After starting the »Cam Designer Basic« the user interface is displayed with the master axis
and a slave axis. You can either continue to process the project or call a new project.

How to create a new project...

Go to the symbol bar of the »Cam Designer Basic« and click the symbol [ or select
File=*New to start a new project:

Detailed information about the individual steps can be found in the following subsections.

6.1.1 Step 1: Defining the features of the master axes
The entries in the axes reflect the machine constants. Therefore, only work with real val-
ues.
Master E]@
Mame |Master
Scale M achine
Mirimum  |0.0000 Unit |° j Gear factors
Maximum [360.0000 22= |10
A<
Cycles
B0.00  Cycles/min el yel
E0.00 Fated cycles/min 360.0000
Incrementunit
18204
Cancel

» The master axis can be a real or virtual axis.

i Note!

If you only use a virtual master, then enter in the group field Machine under
Gearbox factor in the input field z2 100 and in z1 1. This serves to achieve a high-
er resolution of the master angle.

The master axis has the features of an electrical shaft.

22 2.1EN-09/2005 mnze
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The following overview shows the relevant global data for the electrical shaft function. Sig-
nal flow between the template functions for the Electrical shaft.

Virtuziliaster

Verts hafE xt
Position

o _chVershartEx o

Verts hafte xt
Velocity

|-

o _dnverdShaftPosSet p

o hTypeCfiier S halfExd

 —
x
offset
@ anxOffset_p
[ ¥
Virtual :
ChutchXA Xis .

o_ahVerRShaRCEchE O p
g _anvertShaiiCamDatalin_p

Cam
Basic
Operation

g chVertshatPosAct_p
o_nverShatt ety Act_v
o chVerShaftiengihAct 5

Q@ berShaftExtEnabie

Cam function

» Enter the indicated values into the dialog box Master ein.

Dialog object

Input field Name

Input field Minimum
Combination field Unit *

Input field Maximum *

Input field Cycles/min

Input field
Rated cycles/min

Input field
Gear factors z2/z1 *

Input field Feed constant *

Fields must be filled with * !

Description

Name of the master axis

In the dialog box Master the 0.0000 must always be entered here.
The unit used

Cycle
+ Anelectrical shaft can be divided e.g. from 0° to 360° or from 0 to 100mm.
« Inthis case, one master cycle amounts to 360° or 100mm

Production cycles in 1/min

The value can maximally amount to 199%.

« The machine speed which you want to reach with this profile can be set in the in-
put field Cycles/min.

« Serves the display
—to dimension the acceleration
—of the time cams of the cam group.

Production cycles in 1/min

The nominal value can maximally amount to 199%.

« The maximum possible machine speed can be entered in the input field Rated
quantity cycle/min.
This entry is important for the acceleration precontrol.
(Servo PLC / servo cam 9300EK)

Ratio of an upstream gearbox.
(e.g.100/1 as real value)

Path per revolution at the output end of the gearbox

(if an angle is stated, one revolution = 360°)

The physical unit entered is converted to the encoders.

« Enter, for instance, the leadscrew pitch.

« When entering increments, enter the number of increments per revolution.
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Note!

o

If you use a virtual master, enter in the group field "Machine" under "Gearbox
factor" 100 in the input field z2 and 1 in the input field z1. This serves to achieve
a higher resolution of the master angle.

How to define the properties of the master...

1. Goto the Master dialog box and select the properties of the master.
« The Name of the master is indicated on your worksheet.
 The Cycles are the maximum number of operating cycles per minute.

2. Click Next to proceed with the next step.

6.1.2 Step 2: Defining the properties of the slave axis
The entries in the axes reflect the machine constants. Therefore, only work with real val-
ues.
Slave E]@
MName |Slave 1
Scale Machine
Minirnum |U.DDDD Uit |mm j Gear factors
Masimum [100.0000 &=
asfi
Curve
Paints [max 233) |50 Feed constant
[unit/revolution]
I Absalute data madel 360.0000
Iv Background drawing Color increment/unit
182

24

D ata of drive controller

Type | Servo-PLC/ECS-Servosystem j Curves (1-48] |48
GOC fle | []
Crive | J

Cancel |

» Enter the indicated values into the dialog box Slave.

2.1EN-09/2005
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Dialog object
Input field Name

Input field Minimum *

*

Input field Maximum
Combination field Unit *

Control field
Absolute data model

Relative data model

Input field Curves *
Input field Points *
Group field

Background layout

Input field Gearbox factors
22/21*

Input field Feed constant *

Group field
Data of drive controller

Fields must be filled with * !

efesotomasyon.com - Lenze
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Description

+ The slave axis must have a definite name (e.g. Slavel)
and must not be used for other slaves at the same time.

« The name of the slave axis is used by the CamDesigner. CamDesigner creates a
Slavel.LC9 or Slavel.LC7.
In this *.LC9-file or *.LC7-file all profile data, cams and position marker are stored.

Set range of motion

Selection of the unit

When using the absolute data model, you have internal or external (PC) access to

each single base point. However, a fewer number of base points is available then.

« Ifthe control field Absolute data model is not marked, the relative data model is
used. When using the relative data model, more base points are available. The
base points are distributed automatically.

- Iftherelative data model is used, the entire profile can only be accessed with the
Cam Designer Basic/Professional or Cam Loader to change profile data. The pro-
file data cannot be changed via access from a PLC.

Maximum number of the curve profile to be stored.
Reserves should be considered in the maximum number of curve profiles.

Number of base points
Maximally 1 base point/ms or less

Curves are distinguished by colour.
Improved representation of the curves in multi-axis applications.

Ratio between motor and tool

Example: multi-stage gearbox

Gearbox numerator = z2 X z4 = 28 X 32 = 896 (value of z2)
Gearbox denominator = z1 X z3 =23 X 15 = 359 (value of z1)

Path per revolution at the output end of the gearbox.

(If an angle is stated, one revolution = 360°)

The physical unit entered is converted to the encoders.

« Enter, for instance, the leadscrew pitch.

« When entering increments, enter the number of increments per revolution.

The selection field Type serves to select a target system.

+ Servo PLC/ECS servo system

+ 9300 EK (9300 servo cam)

The input field GDC file serves to import a GDC file.

« Only if 9300 EK (9300 servo cam) has been selected.

Assignment of a drive via the bus address.

Shows the path of the selected drive.

The button ... serves to select a drive.

- The assignment is only necessary if profiles, cams etc. are to be changed.
« To change profiles, cams etc. online, all drives must be online.
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» The name of the slave axis is shown in the worksheet and also used for the LCx-file.
Moreover, a subdirectory with this name is created in the project directory.

» When selecting the Type "9300 EK (9300 servo cam profiler)" you can optionally indi-

cate the corresponding GDC file. The Gear factors and the Feed constant will then be
automatically read from this file.

D ata of drive controller

Type | Servo-PLC/ECS-Servosystem j Curves (1-48] |48
GOC fle | []
Crive | J

» If you have an online connection you can use the =] button after the Drive input field
to assign a drive to the slave axis.

Drive Selection E]@
=] Lenze. OPC_DriveServer.d ak. |
E Orline
=42 Offline Caned
(G Drive: 1::EthemetTAN 2180

Selected Drive

» The selections under Absolute data model and Curve have a direct influence on the
maximum number of points. If you need more points for the table of points deactivate

the selection Absolute data model and use the relative data model or reduce the value
under Curve.

» The maximum Curve depends on the selected type.

How to define the properties of the slave...

1. Gotothe Slave dialog box to select the properties of the slave axis.

2. Click Next to proceed with the next step.
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Step 3: Set profile options

The General dialog box can be accepted as shown.
When using the menu command Edit—Project Settings... the Settings dialog box is dis-

played. In the dialog box the project settings can be changed afterwards.

Productrumber |0

Type of Rounding Options
" Automatic Rounding [~ &ctivate Expert Mode
" Defined Steps Mormalized Velocity and Acceleration
- far curves
M -
ane Show Derivatives of Polpgons as
Interpolated Faints
Rounding Values Usze zame Scale for Background
% Steps ’— Axis like Active Auis
r-Steps

Path LCx-File |E: “ProgrammeLenze\CamDesigner_P_2_3MExample

< Back

.

» Enter the indicated values into the dialog box General ein.

2.1EN-09/2005
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Dialog object

Description

Option field All position values of the master(X) and slave(Y) are automatically rounded to suita-
Automatic rounding ble values.
Option field The position values of master and slave are rounded to a multiple of the defined in-

Defined steps
Option field None
Input field X steps

Input field Y steps

crements X steps/Y steps.
The position values are not rounded.

Value for Defined steps
The position values of the master are rounded to a multiple of the value entered.

Value for Defined steps
The position values of the slave are rounded to a multiple of the value entered.

Control field Values of the profile objects Sloped Sine (Bestehorn) and Polynomials can be modi-
Activate Expert Mode fied.
Control field Scaled display of the derivations.

Normalized Velocity and Ac-
celeration for curves

Control field
Show Derivatives of Poly-
gons as Interpolated Points

Control field

Use same Scale for
Backgound Axis like Active
Axis

Input field Product number

Input field Path LCx-file

In the linear interpolation, the speed is mathematically indicated as staircase and
the acceleration as pulse.

The axes in the background are indicated with the same scaling as the axis in the
foreground. This enables the profiles to be compared directly.

Number of the product. The index of the profile data is integrated in the structure of
the controller.

Display of the index for storing the LCx-files.

» Intheinput field Product number a numerical value can be entered for the profile to be

processed.

— Servo PLC,0to 47

— 9300EK servocam,0to 7

» Press the button J to open the path in which the files (LCx-files) are stored.

For the download via DDS or Global Drive Loader the files can be loaded from the directory.

i Note!

Information on the single menu items can be found in the Online Help.

Make sure that the product numbers are not assigned twice and the correct path
has been selected for the LCx-file.

If the project is stored with Save as..., it should be stored in the same directory as

the LCx-files.

After the basic settings have been selected by means of the wizard, you can add more
slaves to your project if required for your drive application.

Lenze
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Step 4: Defining the file name and directory for a project

@ Tip!

We recommend to store the project now so that the settings in the dialog boxes do
not get lost. In case of simple storing the project is called Noname.

An own project directory should be prepared for each project to be created. For this
purpose, the project should be stored with Save as into a particular project directo-
ry.

« All path names within a project are relative and refer to the project directory.

« Ifyouwant to transfer a project to another PC, simply copy the project directory
to the corresponding PC.

How to define the file name and directory for a new project...

1.

2.
3.

4.

Go to the Save as dialog box and select the directory in which you want to store the
new project.

Enter a name for the new project in the File name input field.

Click OK to confirm the settings for the new project and close the Save as dialog
box.

Go to the New project dialog box and click Next to proceed with the next step.

Step 5: Adding a slave axis

New slaves are added at the end of the list. You can enter a symbolic name for the new
slave which will be indicated on your worksheet.

e

Tip!

The menu commands mentioned are partly also included in the context menu of
the right mouse button.

2.1 EN - 09/2005 29



efesotomasyon.com - Lenze

Cam Designer Basic
Operation
Create a new project

How to add another slave to your worksheet...
1. Mark the master axis in the object list.

2. Select the command Edit=»Slave axes=Add new axes.

« The dialog box Project settings of slave 2 is displayed (optional). You can accept
the settings.

Settings: Slave 2 @g|
Name |Slave 2
Scale Machine
Minirnum |U.DDDD Uit |mm j Gear factors
Masimum [100.0000 &=
a-f
Curve
Paints [max 233) |50 Feed constant
[unit/revolution]
I Absalute data madel 360.0000
Iv Background drawing Color increment/unit
182
D ata of drive controller
Type |Servo-F‘LE.-"EES-Servosystem j Curves (1-48] |48
GOC fle | []
Crive | J
Cancel |

3. Define the name and properties of the slave axis in the dialog box Project settings.
« The name of the slave is also used as name for the LCx file.

« The maximum product number determines the minimum number of curves.
The maximally possible entry depends on the target system.

[» How to define the properties of the slave..|({ 26)

4. Select OK to accept the setting and close the dialog box.
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P Create for the example a project with three slave axes.

» The finished product must look as follows:

# Global Drive CamDesignerBasic - [Noname2] E
2" Fle Edit View Draw Window ? — | &
LEzES ) K) m e N SN E o N8
B Position [rmm] Slave 3

100 T T T

= s s s s s s s
e R R AL FEEEEREEE R R .

QD Slave 1 B0 R e e A Rnasass --
e O SRS o R S L

Slave 2 : i i i i : i

L ey I e i

QSlaveS -ttt

o 50° 100° 150° 200° 250° 00 "0

j Welocity [mm.'z]
1.0
05 ___________________________________________________________________________
[ femsmmamzes femmemzoas L fomemmasas dp=smces=es +
JFS boccoscancdassasscsabosacsscsagoasacosaadbacsacoscsboaasacoangpoaasacoasbe
-1.0 ) T T T

o 50° 100° 150° 200° 250° 200° 350°

Project | Chiect
&J—J Ready M
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6.1.6

32

Creating further products

Note!

The path of the LCx-file must not be changed.

How to create further projects in »Cam Designer Basic«:

1. Select the command File=Open to open a project already created from the direc-
tory which already contains project data (*.cam).
2. Select an available product to be loaded and press the Open button.
« The selected product, in this example product2, is loaded by the »Cam Designer
Basic«.

Open @@

Look in: |_} Projects j £k B

E0 praduct 1.cam
E0 praduct 2.cam

&

My Recent
Documents
=

Desklop

X

My Documents

-
J

ey
My Computer

.
My Metwark File name: | j

Places : :
Files of type: |EamDesign Files [*.zam) j Cancel

3. Select the command Edit—>Project settings to open the dialog box Settings.
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4. Enter a product number which has not been assigned yet, e.g. 3, into the register
General, input field Product number.

Master] Slave 1 ] Slave 2] Slave 3 General l

Type of Rounding Options
" Automatic Rounding [~ Activate Expert Mode
" Defined Steps Mormalized Velocity and Acceleration
far curves
" Maone

Show Derivatives of Polpgons as
Interpolated Faints

RS Usze zame Scale for Background
#-Steps Axig like Sctive Axiz
¥-5teps
Productrumber |0
Path LCx-File |EI:\Programme\Lenze\EamDesigner_F'_2_3\ExampIe J

Cancel |

5. Store the profile e.g. as product3 and process it, if required.

Next steps

Now you can assign the import files for the slave to the product and add more slaves and
products to your worksheet, if required.
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6.2 Open an existing project

- Tip!
« Itis possible to open several projects (worksheets) simultaneously in the »Cam
Designer Basic«. The commands for arranging the worksheets can be found in

the "Window" menu.
« With a click on the entries 1...4 in the File menu you can open one of the four
projects edited last.

How to open an existing project...

1. Click the symbol & inthe symbol bar or select File=Open.
2. Select the corresponding project file (*.cam) in the dialog box Open.

3. Pressthe button Open.
« After this, the project worksheet will be displayed in the workspace.

6.2.1 Selecting the properties of a slave

The properties of a slave can always be changed.

How to change the properties of a slave...

1. Selectthe corresponding slave axes and select Properties of the slave axis from the
menu of the right mouse button.

2. Gotothe Project settings dialog box and enter the new settings.

[» How to define the properties of the slave..|({ 26)

3. Select OK to accept the settings and close the dialog box.

216N -09/2005 Lenze
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- Tip!
If you want to change the settings of several axes/products you can also use the

command Edit-Project settings....

In the Project settings dialog box that appears you can quickly change between the
different axes/products by clicking the corresponding tabs:

Project Settings E]@
Master l Slavel ] Product 1 ] General]
Name  |Master

Scale Machine

Mirimum  |0.0000 unit [* =] Gear factors
22 =

Mawimurm  |360.0000
zl =

Cycles Feed constant
[unit/revolution]

£0.00 Rated cycles/min 360.0000

inc. unit =182

Cancel

6.2.2 Deleting a slave

i Note!

This function only deletes a slave from the project/worksheet. The correspond-
ing LCx file is not deleted!

Deleting a slave cannot be undone!

How to delete a slave...

1. Select a certain slave axis in the project structure.

2. Select Edit=»Slave axes...»Delete a slave axis or select Delete slave axis from the
menu of the right mouse button.

3. Confirm the query with Yes or No accordingly.
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36

Connection with the OPC server

The internal Lenze DriveServel is used for communication between »Cam Designer Basic«
and target system and LCx-file transfer.

» The DriveServer provides easy integration of drives into open automation structures

based on [0PQ (OLA for Process Control).

» A specially adapted variant of the DriveServer and the bus server for the system bus
(CAN) is part of the »Cam Designer Basic« installation package.

Select File=»Connect to OPC server to connect the Cam Loader to the OPC server or
cancel the connection.
A hook in front of the menu command indicates the connection with the
OPC server.

Downloading the drive data

If connection with the OPQ server has been established it is possible to transfer the drive
data for several slaves in one step. [» Connection with the OPC servel

» The configuration files (LCx files) for the selected axes are created first.

» If you have an online connection with the corresponding target system the LCx file will
be directly transferred to the target system.

i Note!

With the 9300 servo PLC, the LC9 file can only be downloaded if the target sys-
tem includes a DDS project based on Template Cam.

How to download the drive data...

1. Select File=*Download of several axes....
 This command can only be executed if the Cam Loader is connected to the OPC
server.

2. Go to the Download to controllers and select the slaves to be downloaded:

« Ifthe option If necessary, download all data without queries is activated the
data will be downloaded without further queries.

« Ifthe option Do not show this dialog again until next program start is activated
this dialog will not be indicated again until the next program start. This can be
useful for the commissioning of standard systems or in case of frequent down-
loads.
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3. Click the Start Download button to start the data transfer.

Note: If you have not yet assigned a drive to one of the slaves the Drive selection
dialog box opens automatically.

+ Double-click the drive to be assigned to the slave in the DriveServer tree:

+ Click OK to confirm your selection and repeat the assignment for other slaves, if

necessary.
6.5 Saving the project
i Note!

If you open several project simultaneously in the »Cam Designer Basic, this
function refers to the project in the active window.

Click the & icon or select FilesSave to save the project.

G- Tipt

Save your project at regular intervals to protect your data against power failures or
system problems.

If you want to create a backup project on another data carrier or in another direc-
tory use the command FileSave as... instead.

[» Saving a project under another namd

6.6 Saving a project under another name

Note!

If you open several project simultaneously in the »Cam Designer Basic, this
function refers to the project in the active window.

How to save an open project under another name...
1. Select File=»Save as... to open the Save as dialog box.

2. Gotothe Save as list field and select the directory in which you want to store the
project.

3. Enter a name for the new project in the File name input field.
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6.7

38

:@'-

4. Click OKto save the project under the specified name in the selected directory and

close the dialog box.

+ Ifyou select the command File=Save the project will be saved with the new set-
tings.

Note!

Information on the single menu items can be found in the Online Help.

Make sure that the product numbers are not assigned twice and the correct path
has been selected for the LCxfile.

If the project is stored with Save as..., it should be stored in the same directory as
the LCxfiles.

Tip!

This way you can create a new project or a backup project on another data carrier
orin a directory other than the project directory on the basis of the current project.

Exiting Cam Designer Basic

®
1

Note!

If you have not saved the changes made in one or several projects you will be
asked if you want to save them before exiting the Cam Loader.

Select File=»Exit or click the Window icon X in the [Title bai to exit the »Cam De-

signer Basic«.
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Functions

Working with the worksheet

To create a cam profile in the »Cam Designer Basic, specify the required data (boundary
conditions) on the worksheet using graphical elements. This worksheet has two levels ar-
ranged on top of each other. The lowest level is the Object Input Mode and the second level
is the Interpolation Mode.

In each of the levels the graphical elements of the underlying levels are visible and are used
for the following calculations. Only the elements of the active level can be edited, not the
elements of the underlying level(s). This principle is analogous to working with tracing pa-
per. Here, too, information from the lower sheets is available without being able to change
them.

Settings for the worksheet

Select Edit—»Project settings... to open the Settings dialog box. Here you can change the set-
tings of the corresponding project.

i Note!

+ Ensure thatthe maximum value of the range is higher than the minimum val-
ue.

+ Ifyou change the area boundaries afterwards and the project already con-
tains graphical objects, the objects outside the new area boundaries will be
deleted!

Object Input Mode

The Object Input Mode uses graphical elements (objects) to describe the problem to be
solved.

Position [rmm] Slave 1

70k DR SOURL DN PR SRS NP R UG AR SOPPRE A SOBA SO SO

S S
a0t N

20
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7.4

7.5

40

Interpolation mode

In Interpolation Mode, a table of base points is generated from the ideal cam. These value

pairs can then be transferred to the selected target system (Servo PLC,
ECS EA... or 9300EK servo cam).

Uniform distribution of the base points

All points are distributed with the same spacing along the domain.

Position [rmm] Slave 1

LA I A e B
025 B 75 1000 1250 150° 1750 2000 2250 250° 2750 3000 325 350

Note!

o

Before executing the interpolation, ensure that the curve trace is closed.

Worksteps required for a new cam

The following steps are required to create a new cam:

[» Settings of the worksheef( 41)

[» Creation of profiled( 41)
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Settings of the worksheet

1.

How to configure the worksheet:

Select the menu command Edit—=Project settings in the »Cam Designer Basic«.
« The Settings opens.

Go to the Settings dialog box, change to the Master or Slave tab for the master and
slave axis and define the units for the axes.

Close the Settings dialog box with OK.

Creation of profiles

A simple profile is created and transferred to the controller.

For a better representation and obtaining a zero axis, go to the Settings dialog box of the
slave axis and select a negative value (e.g. -20,000) in the Minimum input field and a posi-
tive value (20,000) in the Maximum field.

o

56

Tip!

The following figure shows the options of creating a profile in the »Cam Designer
Basic«.

How to create a profile:

Select the command View—Object Input Mode to take the worksheet to the input
mode.

Create the graphical elements required by using the command in the Draw menu.

Create a profile using all tools available. Ensure that the profile objects do not over-
lap each other and the profile is closed.

Go to the interpolation mode selecting View = Interpolation mode.
Compile the profile selecting File»Create and download LCx-file.

The profiles, cams etc. are transmitted to the LCx-files.
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The worksheet and time derivation might look as follows:

Position [rmm] Slave 1

00 e e e e e
025 B 75 1000 1250 150° 175 2000 2250 250° 2750 3000 3250 350

j Welocity [mm.'z]

SNt SN SR SNBSS SN S
* 2000 225° 2507 2750 3000 W5 360

Profile object Function

A Table Creates a polyline. The base points are connected by lines. If
the object is selected, it can be edited using the command
Edit-Object Properties...

Line: Section with a straight line.

5th-grade polynomial (x5) This section contains a mathematical
f(x)=ax5+bx4+cx3+dx2+ex+f

D Sloped sine function This section contains a sloped sine function
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7.8 Closed profile

- Tip!
To clearly represent the creation of closed profiles, only the corresponding sections
of the »Cam Designer Basic« are shown.

How to create a closed profile:

» First, the important sections (gradients, lines etc.) of the profile must be defined.

» Then, the sections must be connected without jerk, if possible. For this purpose, the
»Cam Designer Basic« has
— the sloped sine function
— the 5th-grade polynomial (x5)

Position [rmm] Slave 1

S D S O M NS NS
0 2 s 75 1000 125 1500 175 2000 225 2500 275 00 325 0

A jerk-free connection in a profile means:

» The coordinates of the end point of an object must be identical with the initial point of
the following connected object.

» The gradient of the end point of an object must be identical with the following connect-
ed object.

Optimise the connection between the 5th-grade polynomial (x5) and a sloping line.

Here, the right end point of the polynominal must be connected with the left end point of
the line.
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» Select the line with a mouse-click.

» Select the menu command Edit->Project settings.
Go to the Line properties dialog box to open the Conditions register.

» Select and copy the value for velocity. The tab cannot be edited.

Properties Line

Pasition  Conditions l

Welocity
0.3077

Acceleration

0.0000

Abbrechen | |

» Select the 5th-grade polynomial (x5) with a mouse-click.

» Select the menu command Edit-Project settings.

Go to the 5th-grade polynomial properties to open the Conditions register.

» Paste the copied value into the input field Right Velocity.

Properties Polynomial (5) @g|

Pasition  Conditions l Eoefficient]

Left Right
Welocity Welocity
|0.1061 |0.3077
Acceleration Acceleration
|0.0000 |0.0000

Abbrechen
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The characteristic of both objects is smooth at the connecting point.

100
a0
a0
70
60
50
40
30

Position [rmm]

Slave 1

» Proceed the same way for all connections. A closed profile with several objects can look

as follows :

Position [rmm]

Slave 1
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The cam group

i Note!

Only available for Software Package - Cam

The settings only apply to the product selected. For the other products, the set-
tings have to be repeated.

Select View—»Edit Cam in the »Cam Designer Basic« to take the bottom window (output ar-
ea) to the corresponding mode.

______________________________________________________________

-------------------------------------------------------------

_______________________________________________________________

T e T e
o 50° 1o0° 1507 200° 2607 300° 3507

Defining the cam type and cam reference

@ Tip!

The cam group can either refer to the X axis or to the Y axis. The cam group func-
tions are available in the context menu of the right mouse button.

How to define the cam type and cam reference:

1. First, define the cam reference for the current data set under Cam for Slave Axis.
« Subsequent changes are not possible. The selected cam data will be deleted and
must be entered again.

2. The cam types for the individual tracks can be defined using the context menu of
the right mouse button.

Position cam in positive effective direction
Position cam in negative effective direction
Position cam Both
Time-based cam in positive effective direction
Time-based cam in negative effective direction

« Ifyou right-click in the track, you can directly change the came type.

3. Select Add New Cam to add a new cam to the corresponding track.
+ You can add up to four cams to every track.
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Cam types
lllustration Meaning
Position cam in positive effective direction
Switch on and switch off point are defined by positions.
___________ The cam switches if the direction of the axis is positive (positive speed).
Position cam in negative effective direction
Switch on and switch off point are defined by positions.
The cam switches if the direction of the axis is negative (negative speed).
Position cam Positive and negative
Switch on and switch off point are defined by positions.
_________ The cam switches in positive and negative direction of the axis.
o Time-based cam in positive effective direction
: The cam switches on at the switch on point if the direction of the axis is positive (positive
_________ speed).
After the selected time, the cam switches off.
o Time-based cam in negative effective direction
: The cam switches on at the switch on point if the direction of the axis is negative (negative
_________ speed).

After the selected time, the cam switches off.

Select Properties of Cam to edit the cam subsequently. In this dialog, time and length data
can be accurately entered. The dialog box is always the same for all cam types. Only the cor-
responding fields on the dialog box are active.

Properties of Cam @

Fosition values Position-Time-Cam

Left 10.0000 I
Right 20.0000 Length [ms] 100.0

‘Working direction
(] 8 | Cancel |

Dialog object Meaning

Input field Left Initial value of the cam

Input field Right Final value of the cam

Selection field Effective Di-  Positive or negative effect

rection

Input field Length [ms] Cam is active (only with time cam)
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7.10 Export of profile data

» Exporting the profile data to the controller via
— Drive PLC Developer Studio (Servo PLC and ECSEA).
— Global Drive Loader.
— Cam Loader.

Target system - Servo PLC, ECSEA and 9300EK servo cam

i Note!

The 9300EK servo cam exclusively works with the Online download.

How to export the profile data:
1. The data must be compiled before being exported.

« For this purpose select View—Interpolation Mode or click ** and then select Ed-

Go

it=>Start of Calculation or press =~ .

2. Select the corresponding slave axis in the »Cam Designer Basic« by means of dou-
ble-click.
3. Goto the interpolation mode and press the LCx file.

« Ifthisfunctionis executed for the first time, a dialog appears which is confirmed
with OK. The system now creates a file with the name of the slave axis and the
ending *.Ic9 or *.Ic7.

« Compiling must be repeated for new profiles, cam groups or position markers
and changes made.

« After every compiling, the data are transferred to the *.Ic9-file or *.Ic7-file.

The following two steps are only required for the Software Package - Cam Offline down-
load.

4. Double-click Resources=CamSupport in the DDS.

5. Click Add Profile Data to Project .
« Adialog appears in which you can select the *.Ic9-file.

@ Tip!
Do not forget to save your CamDesigner Basic project on hard disk or diskette, in

case you want to make subsequent changes. Select File=»Save as... to save the
CamDesigner Basic project under a new name.
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P Repeatthe above-described steps to create all cams required by means of the »Cam De-
signer Basic«.

P After creating all profiles required by means of »Cam Designer Basic«, you can exit the
»Cam Designer Basic« with FilesExit.

7.11 Cam Designer Basic Online Download

i Note!

The download time increases if
« ahigh bus load (cross communication) exists.
» many data was changed.

How to make an Online Download:
1. Switch the »Cam Designer Basic« online by clicking File=Connection to OPC server
or = .
« The button online/offline is only active if the LDS-DriveServer has been started.

The icon e for the LDS-DriveServer is situated in the status bar.
« Ifthe red point in the icon becomes green, the system is online.

2. Select Edit=»Project settings to open the Settings dialog box.

3. Select in Controller data the drive to which the data is to be downloaded.

Lcx
4. Select File-»Create and download LCx-file or ™ to activate the profile or cam
download.

« The data for the current slave axis are written into the *.Icx-file.
« Afterthe download has been started with the button, a progress dialog appears.

@ Tip!

For the commissioning of production machines, the *.Ic9-file can be attached to the
PLC program.
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8 Appendix

8.1 Error numbers, causes & remedies

Error number

Cause

Errors within the DriveServer

E7C18000
E7C18001
E7C18002

E7C18003

E7C18004

E7C18005

E7C18006

E7C18007
E7C18008

E7C18009

50

Error during download preparation.
PLC has not stopped.

Controller inhibit is not set.

Incorrect data type (no LC9 file).

Check sum check is negative
(faulty check sum).

Item can momentarily not be accessed due to
download.

Target system is momentarily busy copying
RAM blocks.

Error occurred after the download.

Error after version comparison during down-
load of an LC7 file.

- Different versions in LC7 file and target
system.

No template "Cam" in the target system.

2.1EN-09/2005

Remedy

Repeat download.
Stop the PLC program in the target system.

Set controller inhibit in the target system
(e.g. via terminal 28 or code C0040).

Create new LCO file.

Restart the download. Increase time-out
time in the system bus configuration tool
(e.g. to 3 seconds).

Repeat download after a few minutes or re-
start your PC.

Start the PLC program in the target system.

Repeat download.

Update the operating system of the 9300 EK.

Create DDS project based on Template Cam
and transfer it into the target system.

Lenze
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A

Absolute data model

Application window

Code
COM

DCOM

DDS

Document window

Drive PLC Developer Studio
DriveServer

Global Drive Loader

Hyperlink

Cam Designer Basic
Appendix
Glossary

Contains both the X and the Y coordinate. Therefore requires more space than
the relative data model. The points are 1:1 transferred from the Cam Loader to
the target system:

« Advantage: The distance between the points can be variable. This allows to
optimise the distribution of the points according to the cam profile charac-
teristics.

- Disadvantage: Compared to the relative data model, less points can be
saved.

|» Relative data model

Window in which programs are displayed under Windows.

Lenze device parameter used to select the device functionality.

Abbreviation for "Component Object Model": Architecture developed by Mi-
crosoft® for the interaction of separately executable software components
(objects) that communicate with each other in the same way and are only con-
nected to each other when the program is being executed.

Abbreviation for "Distributed Component Object Model": COM in which the
executable objects can be distributed to different computers within a local
network.

Abbreviation for "Drive PLC Developer Studio": Development environment for
the creation of IEC 61131 programs for Lenze PLCs.

Window with graphical user interface displayed by a user program in which a
document is created, displayed and edited. Document windows are usually
sub-windows of the program windows.

See DDS.

Lenze software which enables easy integration of drives into open automa-
tion structures based on OPC ("OLE for Process Control").

Lenze software used to transfer PLC programs, parameter sets and application
data to Lenze target systems.

Highlighted reference which is activated by a mouse click.
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IPC

OLE

OPC

PDF

PLC
PLC

Relative data model

Title bar

Vv
VDI 2143

w

Window icon

Worksheet

52

efesotomasyon.com - Lenze

Abbreviation for Industrial PC. Industrial PCs are used in case of special envi-
ronmental conditions, e.g. dirt or vibrations. They are slot CPUs with powerful
processors and TFT displays (often with touch screens).

Abbreviation for "Object Linking and Embedding": Integration of operational
objects into other applications, e.g. Microsoft® Excel spreadsheets into Micro-
soft® Word documents.

Abbreviation for "OLE for Process Control": Defines an interface based on the
Microsoft® Windows® technologies OLE, COM and DCOM which enables data
exchange between different automation devices and PC programs regardless
of driver and interface problems.

» COM
» DCOM

Abbreviation for "Portable Document Format". Universal file format devel-
oped by Adobe for the exchange of electronic documents. The Adobe® Read-
er® is provided free of charge and can be used to display and print PDF files
independently of the application and platform used to create them.

Abbreviation for "Programmable Logic Controller".

Abbreviation for "Programmable Logic Controller".

Only contains the difference between adjacent Y coordinates and therefore re-

quires less space than the absolute data model. The distance between the X

coordinates is transferred as a fixed-comma value to the target system. This

leads to a certain difference between the imported data and the coordinates

calculated by the target system. To compensate for this inaccuracy, the Y val-

ues are re-calculated by means of interpolation .

 Advantage: Compared to the absolute data model, more points can be
saved.

- Disadvantage: The distance between the X coordinates of the points must
always be the same.

|» Absolute data model

Bar at the top of the application window including the program icon and the
program name on the left and the window icons on the right.

VDI guideline "Motion rules for cam mechanisms"

Button at the right end of the title bar which can be used to change the size of
the window or to close the window.

Table including all axes and products of a system or machine project.
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A

Absolute data model Igg

Acc a slave axisf
Adding a slave B4

Appendix @

C

Cam controller I@

Cam Designer Professional E

Cam Manager E

Cam type, cam reference Iﬁ

Cam types Iﬂ

Closed profile |4_3

Conventions used E

Copyright h

Copyright information

Creating products B2

Creation of profiles 41

Curve kg

Cycles h&

D

Data model hg

Deleting a slave axis E

Direct help hﬂf

Document window hg

Download E

E

Electrical shaftg
Error numbers 50

Example project ﬁ

Exiting the program b

Export of profile data I@

F

Feed constant R6
Functions B9

G

GDC file R6

Gear factors hg

Imprint h

Input mode b

Interpolation mode I@

L

Language selection hﬁ

Layout of the safety information b

LCx file E
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Liability

M

master Q

Menu bar E

Motion rules L3
Motion tasks [L2

N

New project Q

(o)

Object |1_8

Online Download Itﬁ

OPC server EE

Open project E

Operation E

Output area hg

P

Profile options hz

Project hz

Project directory Igg

Project structure hz

S

Saving the project E

Screen divider [L8

Servo cam

Slave axis kﬂ

Software Package - Cam b

Status bar E

T

Title bar [L5
Toolbar [L6

Trademarks h

U

Uniform distribution Iﬂ

User interface , hﬂ

w

Working with the worksheet E

Worksheet setting E, ﬂ
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